CH A P T E R

6

Configuring Doors
A door configuration is a set of device hardware, such as locks and readers, assigned to a Gateway’s
interfaces. This chapter includes instructions to create and modify door configurations.

Tip

You can create the door configuration before the related Gateway is physically installed and added to the
network. See Provisioned (Pre-Populated) vs. Discovered Gateway Configurations, page 5-2 for more
information.
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This section includes the following information.
•

Adding Gateways and Doors Using Templates, page 6-2

•

Adding Doors Using Door Templates, page 6-7

Adding Gateways and Doors Using Templates
Use Gateway templates to quickly add a new Gateway configuration. Once the Gateway is added to the
system, you can configure one or more door configurations.
To do this
Step 1

Create the locations for door and devices.
a.

Select Locations & Doors from the Doors
menu.

b.

To create a new site, click Add Base.

c.

To create a sub-location, right-click a location
and select New [Element].

d.

To change the properties for an element,
right-click a location and select Edit.
You can create any combination of location
elements. Door configurations can be
assigned to any level of the hierarchical tree.

Tip

Step 2

Open the Hardware module.
a.

Select Hardware from the Doors menu.

b.

Select Device from the View menu, if
necessary.

Note

Step 3

Use this display

See Viewing Doors and Devices in the
Hardware View, page 5-3 for more
information.

Add a Gateway to Cisco PAM.
a.

Right-click Access Gateway Driver.

b.

Select New Gateway Controller.

Note

Gateways can also be automatically added
to the configuration. See Provisioned
(Pre-Populated) vs. Discovered Gateway
Configurations, page 5-2.
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To do this
Step 4

Select a Door template.
a.

Select Yes.

b.

Select a Template.

c.

Click Next.

Note

Step 5

Use this display

Cisco PAM includes sample templates. To
create or modify templates, see
Understanding Door Configurations and
Templates, page 5-20 and Chapter 7,
“Configuring Door and Device Templates”.

Enter the name, serial number, and location of the
Gateway module.
a.

Name: enter a descriptive name to identify the
Gateway module.

b.

Serial Number: the serial number is unique and
cannot be changed. See Locating Serial
Numbers, page 5-36.

c.

Location: the assigned location of the module.
See Viewing Doors and Devices by Location,
page 5-5.

Note

d.

The Time Zone and Daylight Savings setting
are not configurable if defined by the
template.
Click Next.
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To do this
Step 6

Step 7

Use this display

Edit or enter the properties for each module in the
Gateway template.
a.

Select a module from the list (Gateway, Reader,
Input, or Output).

b.

Click Edit.

c.

Enter a descriptive name for the device.

d.

(Expansion modules only) Enter the serial
number for the module. The Gateway serial
number was entered in the previous screen
(Step 5).

e.

(Reader module only) Select the Reader
connection mode: one door or two door
configuration.

f.

Click Update.

g.

Repeat these steps for each module in the list.

h.

Click Next.

(Optional) If door configurations are included in the
Gateway template, assign each door to a location.
Note

If door configurations are not included in the
Gateway template, complete these
instructions, and continue to Adding Doors
Using Door Templates, page 6-7.

a.

Select a door template from the list.

b.

Click Edit.

c.

Enter the following information:
– Door Name: enter a descriptive name for

the door.
– Door Location: select a location for the

door (see Viewing Doors and Devices by
Location, page 5-5).
d.

Click Update.

e.

Repeat these steps for each available door.

f.

Click Finish to create the door configuration(s).
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To do this
Step 8

Use this display

(Optional). Modify the door and device properties,
if necessary.
a.

Select Location & Doors from the Doors
menu.

b.

Navigate to the door by expanding the locations
as necessary (click on the box next to an icon to
expand or collapse the locations). The door is
located under the location selected when adding
the door (see Step 7).

c.

Double click the door or device to open the
properties window (or right-click the door and
select Edit).

To override a template settings, uncheck the Default
box to activate the field.
For more information, see the following:
•

Chapter 5, “Understanding Door
Configuration”

•

Door Configuration Properties, page 7-25

•

Device Configuration Properties, page 7-27

Tip

You can also modify doors using the
Hardware module. Doors are listed under
the Logical Device driver, or in the
Hierarchical Locations view.
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To do this
Step 9

Use this display

Select Apply Configuration Changes on the
Gateway Driver or on a specific Gateway.
Right-click the Access GW Driver and select
Apply Configuration Changes to download
configuration changes for all Gateways.

•

or

Right-click on a specific Gateway Controller
and select Apply Configuration Changes to
download configuration changes for a single
Gateway.

•

Note

Step 10

Gateways must be in the Up state, signified
by a green triangle in the icon. A dark green
triangle means configuration changes that
have not been applied. For more
information, see Applying Configuration
Changes, page 6-17

(Optional) Continue to Adding Doors Using Door
Templates, page 6-7

Related Documentation
For more information, see the following:
•

Chapter 5, “Understanding Door Configuration”

•

Chapter 7, “Configuring Door and Device Templates”
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Adding Doors Using Door Templates
Complete the following instructions to add a door using a door template. You can accept the default
configurations included in the door template, or override most settings.
To do this
Step 1

Use this display

Verify that the Gateway for the door configuration
exists in the Hardware module.
If the Gateway is not already configured, use one of
the following methods:
•

Adding Doors Using Door Templates, page 6-7

•

Creating Custom Gateway Configurations and
Templates, page 7-2.

Note

Step 2

Step 3

See also Provisioned (Pre-Populated) vs.
Discovered Gateway Configurations,
page 5-2.

Create a new door:
a.

Select Locations & Doors from the Doors
menu.

b.

Right-click a location and select New Door.

Note

If the location does not exist, refer to
Creating the Location Map, page 5-6 for
more information.

Tip

You can also create a door in the Hardware
module. Right click on the Logical Driver
and select New Door.

Enter the General settings:
•

Door name: enter a descriptive name for the
door configuration.

•

Door Template: select the door template that
contains the correct set of door devices. See
Configuring Door Templates, page 7-7 for more
information.

•

Gateway: select the Gateway used for the door
configuration. The devices in the door template
are assigned to the Gateway interfaces.
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To do this
Step 4

Use this display

Select a location for the door.
a.

Select the Location sub-menu.

b.

In the Hierarchical Location field, do one of the
following:

•

Click the drop down menu to select the new
location from a list.

•

Click Set to open a pop-up window and select
the location from a hierarchical map (see
example screen).

•

Click Clear to remove the setting. The door will
appear in the Unassigned category.
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To do this
Step 5

Use this display

Associate each device with a specific interface on a
Gateway module. If the Gateway includes expansion
modules, you can also choose an interface from a
Reader, Input, or Output module.
a.

Select the Associate Devices sub-menu.

b.

Highlight a device (such as Reader) and click
Associate Device.

c.

In the Select Device window, click the New
button.

d.

In the New Device window, select a module and
module interface for the device.

Note

e.

The Gateway module is m00. If expansion
modules such as the Reader, Input, or
Output module are configured on the
Gateway, a selection for each relevant
module is also available.
Click OK.
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To do this
Step 6

Use this display

Accept or modify the device settings.
The configuration for the device is pre-defined by
the door template. You can accept the default
settings, or modify the configuration as necessary.
Changes apply only to the current device and do not
affect the template.
a.

Select the Properties sub-menu.

b.

(Optional) To change the default settings for a
field, deselect the Default check box. Click
Save and Close to save the configuration.

See Device Configuration Properties, page 7-27 for
more information.

Step 7

Step 8

Select the interface for the device in the Select
Device window:
a.

Highlight the interface from the list in the
Available Device field. This list includes the
available unused ports from the Gateway and
any expansion modules attached to the
Gateway.

b.

Click OK to save the change and complete the
device association.

Repeat Step 5 to Step 7 to associate each device to
an interface.
Tip

When all devices are associated with an
interface, a Name appears for each device.
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To do this
Step 9

Use this display

(Optional) Modify the Properties for the door.
a.

Click the Properties sub-menu.

b.

To change the default settings for a field,
deselect the Default check box.

For more information see the following:

Step 10

•

Chapter 5, “Understanding Door
Configuration”

•

Door Configuration Properties, page 7-25

(Optional) Modify the LED Usage Profiles for the
door.
a.

Click the Usage Profiles sub-menu.

b.

To change the default settings for a field,
deselect the Default check box.

See Configuring Reader LED Profiles, page 7-21
for more information.
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To do this
Step 11

Use this display

(Optional) Modify the Facility Codes for the
credential templates used in the door configuration:
a.

Click the Facility Code Information
sub-menu.

b.

Uncheck the Default box to activate the
configuration fields.

c.

Click Add to add a credential template to the
list.

d.

Select a credential template from the drop-down
menu.

e.

Enter the Facility Codes. Separate codes with a
comma (,).

f.

Click Save.

To Edit a credential template:
a.

Highlight the template in the Credential
Template list box.

b.

Click Edit.

c.

Select a credential template from the drop-down
menu.

d.

Enter the Facility Codes. Separate codes with a
comma (,).

To delete a credential template:
a.

Highlight the template in the Credential
Template list box.

b.

Click Delete.

See Configuring Credential Templates, page 7-17
for more information.
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To do this
Step 12

Use this display

(Optional) Modify the Duress Specifications for the
door.
a.

Click the Duress Specification sub-menu.

b.

Uncheck the Default box to activate the
configuration fields.

c.

Click Add to add an alarm to the list.

d.

Select an Alarm from the drop-down menu.

e.

Enter the Code.

f.

Click Save.

To Edit an alarm:
a.

Highlight the alarm in the list box.

b.

Click Edit.

c.

Select an alarm from the drop-down menu.

d.

Enter the Code.

To Delete an alarm:

Step 13

a.

Highlight the alarm in the list box.

b.

Click Delete.

Click Save and Close to save the changes and
return to the main window.
The door configuration is displayed as a child of the
selected location.
Note

Step 14

The door is also listed under the Logical
Driver in the Hardware module.

Apply the door configuration changes.
In the Locations & Doors module, right-click a
location and select Apply Configuration Changes.
Only Gateways in the Up state are updated.
For more information, see Applying Configuration
Changes, page 6-17
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Related Documentation
•

Provisioned (Pre-Populated) vs. Discovered Gateway Configurations, page 5-2

•

Adding Gateways and Doors Using Templates, page 6-2

•

Creating Custom Gateway Configurations and Templates, page 7-2

Modifying Door Configurations
This section includes instructions to modify an existing door or device configuration using the following
methods:
•

Modifying Door and Device Templates, page 6-14

•

Modifying Devices in the Hardware Device View, page 6-14

•

Modifying Devices in Hardware Location View, page 6-15

•

Modifying Devices in the Locations & Doors Module, page 6-16

Modifying Door and Device Templates
For instructions to modify templates, see Chapter 7, “Configuring Door and Device Templates”.

Modifying Devices in the Hardware Device View
To manually revise the properties for a Gateway, expansion module, or other device, do the following:
Step 1

Select Hardware from the Doors menu.

Step 2

Expand the hardware tree, right-click on the device name, and select Edit, as shown in Figure 6-1. You
can also double-click the device name to open the edit window.

Step 3

Click Properties in the device window and edit the settings as necessary. To override the template
settings, deselect the Default checkbox to activate the field. For field descriptions, see Door
Configuration Properties, page 7-25 and Device Configuration Properties, page 7-27.

Step 4

Download the configuration changes to the Gateway. Changes do not take effect until downloaded. See
Applying Configuration Changes, page 6-17.
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Figure 6-1

Edit Menu for a Device in the Hardware Device View

Modifying Devices in Hardware Location View
You can edit door configurations in the Hardware location view, but you cannot edit device properties or
the location map.
Step 1

In the Hardware module, select Hierarchical Location from the View menu.

Step 2

Expand the location tree to display the door configuration.

Step 3

Right-click on the device name and select Edit, as shown in Figure 6-2. You can also double-click the
door to open the edit window.

Step 4

Select a sub-menu and edit the settings as necessary. To override the template properties, deselect the
Default checkbox to activate the field.

Step 5

Download the configuration changes. See Applying Configuration Changes, page 6-17.
Figure 6-2

Edit Menu for a Door in the Hardware Location View
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Modifying Devices in the Locations & Doors Module
In the Locations & Doors module, you can edit all attributes of a door configuration, including device
properties and the location map.
For instructions to modify the location map, see Creating the Location Map, page 5-6.
Step 1

In the Locations & Doors module, expand the location tree to display the door configuration or a specific
device.

Step 2

Right-click on the door or device name and select Edit, as shown in Figure 6-3.

Tip

You can also double-click a door or device to open the edit window.

Figure 6-3

Edit Menu for a Door in the Hardware Location View

Step 3

Select a sub-menu and edit the settings as necessary. To override the template properties, deselect the
Default checkbox to activate the field.

Step 4

Download the configuration changes. See Applying Configuration Changes, page 6-17.

Tip

The names of all hardware elements are editable, including Drivers, Gateways, expansion modules, and
door devices.
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Applying Configuration Changes
Changes made to a door or device configuration in Cisco PAM are inactive until applied to the Gateway
module. You can apply the configuration changes to a specific Gateway, to all Gateways, or to all
Gateways in a location. Applying a configuration downloads the revised configuration file to the
Gateway.
Gateways must be in the Up state, signified by a green triangle in the icon. A dark green triangle signifies
that the Gateway has configuration changes that have not been applied (downloaded).
This section includes the following information.
•

Applying Configuration Changes to Gateways, page 6-17

•

Configuration Management in Provisioned vs. Discovered Configurations, page 6-18

Applying Configuration Changes to Gateways
You can download the configuration to Gateways using either the Hardware or Locations & Doors
modules.

Applying Configuration Changes in the Hardware Module
Select Apply Configuration Changes on the
Gateway Driver or on a specific Gateway.
•

Right-click the Access GW Driver and select
Apply Configuration Changes to download
configuration changes for all Gateways.
or

•

Note

Right-click on a specific Gateway Controller
and select Apply Configuration Changes to
download configuration changes for a single
Gateway.
Gateways must be in the Up state, signified
by a green triangle in the icon. A dark green
triangle means configuration changes that
have not been applied. See Understanding
Device Status Colors, page 5-12.
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Applying Configuration Changes in the Locations & Doors Module
Select Apply Configuration Changes on the
affected Gateway or on a Location.
Specific Gateway
a.

Select Gateway Controllers from the View
menu to display the Gateways.

b.

Right-click a Gateway icon and select Apply
Configuration Changes to download the
configuration for a single device.
or

Multiple Gateways
a.

Right -click a location icon.

b.

Select Apply Configuration Changes.

Note

Gateways must be in the Up state, signified
by a green triangle in the icon. A dark green
triangle means configuration changes that
have not been applied. See Understanding
Device Status Colors, page 5-12.

Configuration Management in Provisioned vs. Discovered Configurations

Note

•

In a Provisioned configuration, the configuration is entered before the Gateway module is brought
online and the configuration is automatically downloaded when the Gateway is added to the
network. Any subsequent configuration changes must be downloaded using one of the methods
described in this section.

•

In a Discovered configuration, the Gateway is added to the network before a configuration is created.
Cisco PAM automatically creates a basic configuration containing the serial numbers of the
Gateway and any expansion modules. Any subsequent configuration changes must be downloaded
using one of the methods described in this section.

•

If a Gateway power-cycles or is disconnected and reconnected to the network, the last configuration
applied to the module will automatically be downloaded when the module comes online.

See Provisioned (Pre-Populated) vs. Discovered Gateway Configurations, page 5-2 for more
information.
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Disabling or Deleting a Device or Door
Disabling a device or door configuration deactivates the item, but does not remove it from the
Cisco PAM configuration. This allows you to remove the device or door from the active configuration
without deleting it entirely. The device or door can be re-enabled, if necessary, and the configuration,
events, logs and alarms associated with the device or door are retained.

Note

Interface and drivers (such as the Access GW Driver and Logical Driver) cannot be disabled.
When you delete a device or door, all configurations and other information, including events and logs,
are also permanently deleted and cannot be recovered. Only deactivated devices or doors can be deleted.
Cisco Systems does not recommend deleting devices since clearing a large number of events can be time
and processor intensive.
This section includes the following information:
•

Disabling a Device or Door, page 6-19

•

Deleting Devices and Doors, page 6-20

•

Enabling a Device or Door, page 6-23

Disabling a Device or Door
To disable a device or door, right-click the item and select Disable from the drop down menu.

Note

Changes are not applied until you download the revised configuration to the Gateways.

Step 1

Select either Hardware or Locations & Doors from the Doors menu.

Step 2

Right-click a Gateway, door configuration, or other device, and select Disable (Figure 6-4).
Figure 6-4

Disabling a Device Using the Hardware Module
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•

Disabling a device: removes the Gateway association and may disable the door configuration. A
confirmation message appears describing the impact of disabling the device.

•

Disabling a Gateway: disables all associated devices and door configurations. A confirmation
message appears describing the impact of the action.

•

Disabling a door configuration: a confirmation window allows you to select the associated devices
to be disabled, as shown in Figure 6-5. Select the devices to be disabled, or check the box for Select
All, and then click Yes.

Figure 6-5

Confirmation Warning When Disabling a Door Configuration

Step 3

Download the configuration changes to the Gateway. Changes do not take effect until downloaded. See
Applying Configuration Changes, page 6-17.

Step 4

(Optional) To delete a device, Gateway or door configuration, see Deleting Devices and Doors,
page 6-20.

Tip

To view disabled devices, select All Devices from the Filter menu.

Deleting Devices and Doors
When a device is deleted, the device is permanently removed from the Cisco PAM configuration. All
events associated with the device are also permanently deleted. Neither the device or the events can be
restored. This is different than disabling a device. When a device is disabled, it remains in the
configuration and can be re-enabled at a later time.

Note

Cisco Systems does not recommend deleting devices since clearing a large number of events can be time
and processor intensive.

Tip

To delete a device or door, you must first enable the delete functions and then disable the device or door.
This section includes the following information.
•

Enabling the Delete Options, page 6-21

•

Deleting a Device, page 6-22
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•

Deleting a Gateway Controller, page 6-22

Enabling the Delete Options
Step 1

Select System Configuration from the Admin menu.

Step 2

Select the Miscellaneous sub-menu, as shown in Figure 6-6
Figure 6-6

Step 3

Note

Device Delete Options in The Admin Module: System Configuration

Select or deselect one of the following:
•

Allow deletion of items that normally may only be disabled: Adds the Delete option to device
and door right-click menus. Devices can be deleted only if they were previously disabled, are not
referred to by another object, and if have no events or alarms. Deleting a device or door permanently
removes the item from the configuration.

•

Allow deletion of devices with events: Adds the Delete option to device and door right-click
menus. This option deletes the device and any associated events. Items with active alarms cannot be
deleted. Devices and doors can be deleted only if they were previously disabled and are not referred
to by another object.

Deleting a device may temporarily impact system performance while the associated events are also
deleted. Do not delete devices and doors unless necessary.

Step 4

Click Save to save the changes.

Step 5

Exit all Cisco PAM windows and restart the application to activate the changes. The Delete menu does
not appear in Cisco PAM until the application is closed and re-opened.
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Deleting a Device
To delete a device, do the following:
Step 1

Enable the Delete functions, as described in Enabling the Delete Options, page 6-21.

Step 2

Disable the device, as described in Disabling a Device or Door, page 6-19.

Step 3

Select All Devices from the Filter menu to display the disabled device(s).

Step 4

Right-click the device and select Delete.

Step 5

Select Yes to confirm.

Step 6

Download the changes to the Gateway, as described in Applying Configuration Changes, page 6-17.

Deleting a Gateway Controller
To delete a Gateway Controller, do the following:
Step 1

Enable the Delete functions, as described in Enabling the Delete Options, page 6-21.

Step 2

Disable all devices in all doors associated with the Controller, as described in Disabling a Device or
Door, page 6-19.

Step 3

Select All Devices from the Filter menu to display the disabled device(s).

Step 4

Delete the Gateway Controller by right-clicking the Controller and selecting Delete.

Step 5

Select Yes to confirm.

Step 6

Download the changes to the Gateway, as described in Applying Configuration Changes, page 6-17.
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Enabling a Device or Door
When a device is disabled, the door is also disabled. To re-enable a door and device, re-associate all
devices and then enable the door, as described in the following example.

Disable and Enable a Device and Door: Example
The following example describes how to disable and then re-enable a device:
To do this
Step 1

Use this display

Disable a device:
a.

Right-click the device and select Disable. A
confirmation message appears.

b.

Click Yes to disable the device. The door is also
disabled.
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To do this
Step 2

Use this display

Re-enable the door.
Note

To re-enable a door, you must reassociate
the device with the door.

a.

Select All Devices from the Filter menu to
display the disabled device(s).

b.

Right-click on the door and select Edit to open
the edit window.

c.

Select the Associate Devices sub-menu, as
shown in the example to the right.

d.

Highlight a device (such as Reader) and click
Associate Device.

e.

In the Select Device window, click the New
button.

f.

In the New Device window, select a module and
module interface for the device.

Note
g.

The default Gateway module name is m00.
Click OK.
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To do this
Step 3

Use this display

Accept or modify the device settings.
Click Save and Close to save the configuration.

Step 4

Step 5

Select the interface for the device in the Select
Device window:
a.

Highlight the interface from the list in the
Available Device field. This list includes the
available unused ports from the Gateway and
any expansion modules attached to the
Gateway.

b.

Click OK to save the change and complete the
device association.

Associate additional devices, or save the changes:
a.

Verify that an entry appears in the Name column
for each device.

b.

Associate any additional devices that do not
appear with a Name.

c.

Click Save and Close to save the configuration
and re-enable the device.

Cisco Physical Access Manager User Guide
OL-20930-02

6-25

Chapter 6

Configuring Doors

Enabling a Device or Door

To do this
Step 6

Use this display

Re-enable the door.
Note

The device should appear again under the
door.

Right-click the door name, and select Enable.

Step 7

Apply the door configuration changes.
Right-click a location or Gateway and select Apply
Configuration Changes. Only Gateways in the Up
state are updated.
For more information, see Applying Configuration
Changes, page 6-17.
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Cloning a Gateway Configuration
Cloning a Gateway creates an exact copy of a Gateway configuration, including any attached expansion
modules, devices, or door configurations. Only the names, locations, and serial numbers of the devices
and doors are changed in the clone. A Gateway clone is an independent copy, and is used to configure
one other Gateway module. Changes to the original Gateway or to the clone Gateway do not effect each
other.
To create a Gateway clone, do the following:
Step 1

Select Hardware or Locations & Doors
from the Doors menu.

Step 2

Right-click a Gateway Controller and
select Clone Gateway.

Step 3

Enter the names, serial numbers, and
locations for the clone Gateway. For
expansion modules, note the type of
expansion module that each serial number
is assigned to, and match it to the same
type of module for the clone
configuration.

Step 4

(Optional) Click Clone all module names
to use the source names for the clone
configuration.

Step 5

Click OK.

Step 6

Right-click the Gateway icon and select Reload Gateway Configuration. This command downloads the
full configuration and replaces the existing file on the specified Gateway. The Gateway must be installed
and in the Up state, or the reload will fail.

Step 7

Add doors or revise the configuration as necessary. See Configuring Doors, page 6-2 for more
information.

Tip

To create a template from a Gateway configuration, see Creating Custom Gateway Configurations and
Templates, page 7-2.
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Configuring Device Groups
Use device groups to create sets of devices for use in other configuration menus such as Event Policies
(Modifying Default Event Policies, page 10-28) and Access Policies (Configuring Access Policies,
page 9-2).
For example, a device group for all lobby doors can be created, and then specified in an access policy.
Users assigned to that access policy will only have access to doors in that device group.
To configure device groups, do the following:
Step 1

Select Device Groups from the Doors menu.
The main window opens, as shown in Figure 6-7.
Figure 6-7

Step 2

Device Groups Main Window

Add or edit a device group.
•

To add a new device group, click Add.

•

To modify an existing record, select the record and click Edit, or double-click the entry.

Note

To remove a device group, you must first remove any configurations for that group in the Access
Policy or Event Policy modules. Once the associations are removed, select the entry and click
Delete. If you attempt to remove a device group that is still in use, a pop-up message appears
with a summary of the access and event policies that are associated with the group.
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Step 3

In the detail window (Figure 6-8), enter a Name for the device group.
For example: Employee Doors.
Figure 6-8

Step 4

Device Group Detail Window

Select the device Type.
For example: Door, Gateway. Module, Reader, etc.
When selected, the Group Members field displays the devices for that device type.

Step 5

Tip

Select the devices to include in the group. For example, in Figure 6-9 the lobby doors are selected to
create a lobby door group.

•

Devices can belong to multiple groups.

•

Check the site name to select all the devices for that site.

•

Click Uncheck All to clear the selections.
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Figure 6-9

Step 6

Door Groups: Choose Devices Window

Click Save and Close to save the changes and exit the Device Group detail window. The new door group
appears in the main window (Figure 6-7).
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Replacing a Gateway or Expansion Module
To replace a Gateway or expansion module with a new device, complete the following instructions.

Note

The replacement module must be the same as the old module, and all device connections must be the
same. All configurations and properties remain the same.

Step 1

Physically remove the old device. Cisco PAM automatically detects the removal and disables the device
configuration.

Step 2

In the Hardware module, select All Devices from the Filter menu to display the disabled device.

Step 3

Right-click the device icon and select Replace Gateway or Replace Module. These commands are
enabled only after a device is disconnected.

Step 4

Enter the serial ID (number) of the replacement device and click OK.

Step 5

Physically install the replacement Gateway or expansion module.

Connect expansion modules to the same Gateway interface. The Gateway automatically
recognizes the new module, and enables the device in Cisco PAM.

Tip

Step 6

Right-click the Gateway icon and select Reload Gateway Configuration. This command downloads the
correct (full) configuration to the Gateway.

Changing Gateway Passwords
You can change the password for one or more Gateways in the Hardware module, or the Locations &
Doors module.
Step 1

Display the Gateways:
•

Select Locations & Doors from the Doors menu and select Gateway Controllers from the View
menu.
or

•
Step 2

Select Hardware from the Doors menu and expand the Access GW Driver device tree.

Change the password for one or more Gateways:
•

To change the password for a single device, right-click a Gateway icon and select Reset Gateway
Password.
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•

To change the password for a multiple devices, right-click the location icon or the Access GW Driver
and select Reset Gateway Password. Changing the password for a location affects only the
Gateways at that location. Changing the password for the driver affects all the Gateways in the
system.

See Figure 6-10 and Figure 6-11 for examples to change the Gateway passwords.
Figure 6-10

Reset Gateway Password

Figure 6-11

Reset Gateway Password

Step 3

(Optional) In the Reset Gateway Password window (Figure 6-12 on page 6-33), click Preview to view a
list of Gateways. Gateways must be in the Up or Down state. If a Gateway is in the Unknown state, the
device is displayed in red and the password is not changed.

Step 4

Enter a new password and click OK (Figure 6-12).
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Figure 6-12

Step 5

Tip

Enter a Gateway Password

Verify the status of the change:
•

In the Locations & Doors module, select a location. The command status is displayed under
Extended Status in the lower right of the screen (see Figure 6-10 on page 6-32).

•

In the Hardware module, select the Access GW Driver. Select the Command Status tab under
Extended Status in the lower right of the screen (see Figure 6-10 on page 6-32).

To change Gateway settings using a direct PC connection, you must connect a PC to the module and enter
a password, as described in the Cisco Physical Access Gateway User Guide.
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Device and Driver Commands in the Hardware Device View
To access the following commands, right-click on the driver or module icon in the Hardware module
(select Hardware from the Doors menu).
•

Access GW Driver Commands, page 6-34

•

Gateway Controller Commands, page 6-35

•

Reader Module Commands, page 6-37

•

Input and Output Module Commands, page 6-37

•

Logical Driver Commands, page 6-38

Access GW Driver Commands
Table 6-1

Access GW Driver Commands

Command

Description

Apply Configuration Changes

Downloads configuration changes to all Gateway modules.
Changes made in Cisco PAM are inactive until applied with this
command. See Applying Configuration Changes, page 6-17.

Apply Credential Changes

Downloads credential changes to all Gateway modules. Credential
changes made in Cisco PAM are downloaded every 60 minutes by
default, and are inactive until then. Use the Apply Credential
Changes command to download the credential configuration to all
Gateways immediately. See Downloading Credential Changes to
the Gateway Modules, page 8-10.

Reset Gateway Password

Resets the password on all configured Gateways. See Changing
Gateway Passwords, page 6-31.

Bulk Image Upgrade

Downloads a firmware image to all Gateway modules. See
Upgrading Gateway Firmware Images Using Cisco PAM,
page B-18.

Run System Sanity Report

Creates a snapshot of potential inconsistencies in the system. See
Generating a System Sanity Report, page 5-16.

View Recent Events

View a list of recent events for all Gateways. See Viewing the
Recent Events for a Device, Driver, or Location, page 5-14.

New Gateway Controller

Creates a Gateway configuration entry. See Configuring Doors,
page 6-2.

Edit

Opens the Edit window to revise the driver properties.

Disable

Disables all Gateways, attached devices, and door configurations.
See Disabling or Deleting a Device or Door, page 6-19. Disabled
Devices can be re-enabled.

Delete

Permanently removes the Gateways and attached devices from the
configuration. See Disabling or Deleting a Device or Door,
page 6-19.
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Table 6-1

Access GW Driver Commands (continued)

Command

Description

View Device Status

Opens a new window containing the Status and Extended Status
information. See Viewing Device and Door Status, page 5-9.

Show in Graphic Map Editor

The Graphic Maps Editor module allows operators to add facility
maps, plot and organize devices for use in the Graphic Map
Viewer module. See Graphic Map Editor, page 10-42.

Gateway Controller Commands
Table 6-2

Gateway Controller Commands

Command

Description

Apply Configuration Changes

Downloads configuration changes to the specified Gateway
module. Changes made in Cisco PAM are inactive until applied
with this command.
Note

Gateways must be in the Up state, signified by a green
triangle in the icon. A dark green triangle means
configuration changes that have not been applied. For
more information, see Applying Configuration Changes,
page 6-17.

Reload Gateway Configuration

Downloads the full configuration and replaces the existing file on
the specified Gateway. The Gateway must be installed and in the
Up state, or the reload will fail.

File Manager

Provides info of various files available on the Gateway:
•

Images: Set of firmware images available on the Gateway
including status. See Upgrading Gateway Firmware Images
Using Cisco PAM, page B-18 for more info.

•

Core Files: Core files for any core dumps that occurred on the
Gateway.

•

Log File: List of debug log files.

•

Technical Summary: Technical data to assist in debugging
issues.

Note

Each screen also provides options to download or upload
the files.

Save As Gateway Template

Saves the Gateway configuration as a template that can be used to
configure additional devices. See Creating Custom Gateway
Configurations and Templates, page 7-2 and Gateway Templates,
page 5-23.

Clone Gateway

Creates an exact duplicate of a Gateway configuration. See
Cloning a Gateway Configuration, page 6-27.

Reset Gateway

Performs a soft reset of the Gateway. See the Cisco Physical
Access Gateway User Guide.
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Table 6-2

Gateway Controller Commands (continued)

Command

Description

Set Gateway Address

Replaces the Gateway Network configuration.
Note

The Gateway network settings can also be configured
using a direct connection to the Gateway. See the Cisco
Physical Access Gateway User Guide.

If this command is used to enter the Gateway Network
configuration, all settings on the Gateway are replaced. You
cannot use this command to modify only selected parameters.
To view the current settings, select the Gateway in the Hardware
module. In the Extended Status screen (bottom right window),
select the Gateway Network Address tab.
Format Gateway Flash

Erases and formats the Gateway flash memory.

Replace Gateway

Replaces the current Gateway with new Gateway device. This
command is active only when the device is disconnected from
Cisco PAM (Unknown State). The command is used to replace a
faulty device. See Replacing a Gateway or Expansion Module,
page 6-31.

Reset Gateway Password

Resets the password for the selected Gateway device. You can also
reset the passwords for multiple Gateways. See Changing
Gateway Passwords, page 6-31.

Download All Credentials

Downloads all credentials to the Gateway to ensure all required
data is correct. This command should be used only if a problem
exists.

Credential Look up

Search for the credentials on a Gateway.

View Recent Events

View a list of recent events for the Gateway. See Viewing the
Recent Events for a Device, Driver, or Location, page 5-14.

New Module

Adds a new expansion module to the Gateway configuration.

Edit

Opens the Edit window to revise the device properties.

Disable

Disables the device and all attached devices. Also disables any
door configurations. See Disabling or Deleting a Device or Door,
page 6-19. Disabled Devices can be re-enabled.

Delete

Permanently removes the device and all attached devices from the
configuration. See Disabling or Deleting a Device or Door,
page 6-19.

View Device Status

Opens a new window containing the Status and Extended Status
information.

Show in Graphic Map Editor

The Graphic Maps Editor module allows operators to add
facility maps, plot and organize devices for use in the Graphic
Map Viewer module. See Graphic Map Editor, page 10-42.
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Reader Module Commands
Table 6-3

Reader Module (Module 00) Commands

Command

Description

Reset Module

Resets the device.

Squelch

Suppresses any events from this module. Events are not reported
or saved.

Unsquelch

Undo squelch. Events are reported and saved.

View Recent Events

View a list of recent events for the module. See Viewing the
Recent Events for a Device, Driver, or Location, page 5-14.

Replace Module

Replaces the current module with new device. This command is
active only when the device is disconnected from Cisco PAM
(Unknown State). See Replacing a Gateway or Expansion Module,
page 6-31.

Edit

Opens the Edit window to revise the device properties.

Edit Reader Connection Mode

Defines if the module supports connections for one or two readers.
See the Cisco Physical Access Gateway User Guide for more
information on reader connections.

Disable

Disables the device and all attached devices. Also disables
referenced door configurations. See Disabling or Deleting a
Device or Door, page 6-19. Disabled Devices can be re-enabled.

Delete

Permanently removes the device and all attached devices from the
configuration. See Disabling or Deleting a Device or Door,
page 6-19.

View Device Status

Opens a new window containing the Status and Extended Status
information.

Show in Graphic Map Editor

The Graphic Maps Editor module allows operators to add
facility maps, plot and organize devices for use in the Graphic
Map Viewer module. See Graphic Map Editor, page 10-42.

Input and Output Module Commands
Table 6-4

Input and Output Module Commands

Command

Description

Reset Module

Resets the device.

Squelch

Suppresses any events from this module. Events are not reported or
saved.

Unsquelch

Undo squelch. Events are reported and saved.

Replace Module

Replaces the current device with new device. This command is active
only when the device is disconnected from Cisco PAM (Unknown
State). The command is used to replace a faulty device. See
Replacing a Gateway or Expansion Module, page 6-31.
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Table 6-4

Input and Output Module Commands (continued)

Command

Description

View Recent Events

View a list of recent events for the module. See Viewing the Recent
Events for a Device, Driver, or Location, page 5-14.

Edit

Opens the Edit window to revise the device properties.

Disable

Disables the device and all attached devices. Also disables
referenced door configurations. See Disabling or Deleting a Device
or Door, page 6-19. Disabled Devices can be re-enabled.

Delete

Permanently removes the device and all attached devices from the
configuration. See Disabling or Deleting a Device or Door,
page 6-19.

View Device Status

Opens a new window containing the Status and Extended Status
information.

Show in Graphic Map Editor

The Graphic Maps Editor module allows operators to add facility
maps, plot and organize devices for use in the Graphic Map Viewer
module. See Graphic Map Editor, page 10-42.

Logical Driver Commands
To access the following commands, right-click on the Logical Driver icon in the Hardware view.
Table 6-5

Logical Driver Commands

Command

Description

View Recent Events

View a list of recent events for the configured doors. See Viewing
the Recent Events for a Device, Driver, or Location, page 5-14.

New Door

Creates a new door configuration. See Configuring Doors, page 6-2.

Edit

Opens the Edit window to revise the driver properties.

Disable

Disables the device and all attached devices. See Disabling or
Deleting a Device or Door, page 6-19. Disabled Devices can be
re-enabled.

Delete

Permanently removes the device and all attached devices from the
configuration. See Disabling or Deleting a Device or Door,
page 6-19.

View Device Status

Opens a new window containing the Status and Extended Status
information.

Show in Graphic Map Editor

The Graphic Maps Editor module allows operators to add facility
maps, plot and organize devices for use in the Graphic Map Viewer
module. See Graphic Map Editor, page 10-42.
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Door Modes and Commands
Door Modes
A door mode indicates the state of the door, including one of the following:

Tip

•

Open: The door is physically held open. The lock is in Unlocked state, the door sensor is
dis-engaged. When door is in Open mode, and a badge is presented to a reader, the badge data is
read but may not be validated.

•

Close: The door is physically closed. The lock is in Unlocked state and the door sensor is engaged,
indicating door is closed. When the door is in Close mode, and a badge is presented, the badge data
is read but may not be validated.

•

Lock: The door is physically closed and the lock is in Locked state. The Door Sensor is engaged.
When the door is in Lock mode, and a badge is presented, the badge data is read and validated: if
access is granted the lock is opened, access is denied if the badge is invalid.

•

Secure: The door is locked and the deadbolt is applied. The deadbolt remains in place until issue a
command to change the door mode (such as Reset Door Mode). See Door Commands, page 6-39
for more information.

For more information, see Understanding Door Modes, Door Schedules, and the First Unlock Feature,
page 5-25.

Door Commands
The following commands are available when you right-click a door configuration in the Device or
Locations view (available in either Hardware or Doors & Locations).
Table 6-6

Door Commands in Locations View

Command

Description

Grant Access

Grants access to the door.

Grant Access ADA

Grants access to a door, and applies the ADA settings, such as the
amount of time the door is held open, or use of a mechanical swing
device. See Door Configuration Properties, page 7-25 for more
information.

Update State

Updates the door state displayed in the hardware tree.
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Table 6-6

Door Commands in Locations View (continued)

Command

Description

Set Door Mode Lock

Overrides the current door mode and locks the mechanism. The
door mode remains set to Lock until you do one of the following:
•

Select the command Reset Door Mode to return the door to
the configured mode (such as the default mode or scheduled
mode).

•

Select a different Set Door Mode command.

•

Reset the Gateway using the Reset Gateway command. You
can also reboot the Gateway.

•

Successfully execute the Reload Gateway Configuration
command.

•

Invoke the Apply Configuration Changes command (if no
configuration changes were made, then no changes are sent to
the Gateway. The previous door mode still applies).

Note

Set Door Mode Open

Badge access is still allowed, or you can manually grant
access with the Grant Access command.

Overrides the door mode and unlocks the mechanism. The door
mode remains set to Unlock until you do one of the following:
Overrides the current door mode and locks the mechanism. The
door mode remains set to Lock until you do one of the following:
•

Select the command Reset Door Mode to return the door to
the configured mode (such as the default mode or scheduled
mode).

•

Select a different Set Door Mode command.

•

Reset the Gateway using the Reset Gateway command. You
can also reboot the Gateway.

•

Successfully execute the Reload Gateway Configuration
command.

•

Invoke the Apply Configuration Changes command (if no
configuration changes were made, then no changes are sent to
the Gateway. The previous door mode still applies).

Note

Badge access is still allowed, or you can manually grant
access with the Grant Access command.
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Table 6-6

Door Commands in Locations View (continued)

Command

Description

Set Door Mode Secure

If a door includes a deadbolt device, this command overrides the
door mode and applies the deadbolt. The deadbolt remains in place
until you do one of the following:
Overrides the current door mode and locks the mechanism. The
door mode remains set to Lock until you do one of the following:
•

Select the command Reset Door Mode to return the door to
the configured mode (such as the default mode or scheduled
mode).

•

Select a different Set Door Mode command.

•

Reset the Gateway using the Reset Gateway command. You
can also reboot the Gateway.

•

Successfully execute the Reload Gateway Configuration
command.

•

Successfully execute the Apply Configuration Changes
command (if no configuration changes were made, then no
changes are sent to the Gateway. The previous door mode still
applies).

Note

Badge access is still allowed, or you can manually grant
access with the Grant Access command.

Reset Door Mode

Resets the door to the configured default mode.

Set Admin Down

Places the door in the Down state.

Set Admin Up

Places the door in the Up state.

Activate Access Levels

Manually activates the access levels for one or more doors. Use
this command if the access levels were deactivated.

Deactivate Access Levels

Manually deactivates all access levels for one or more doors. All
access is denied.
Activate/deactivate access levels for multiple doors:
•

Select Locations & Doors from the Doors menu, right click a
location and select Deactivate Access Levels. All doors in
that location are affected.

Activate/deactivate access levels for a single door:
•

Right-click a door icon in the Locations & Doors module and
select the command.

•

In the Hardware module, expand the Logical Driver device
tree, right-click a door and select the command.

To reactive the access levels, select Activate Access Levels.
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